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Overview 
System administration tasks include setting up security, configuring module data, loading wInsight data 

periodically, setting up collaboration tools, and a variety of other miscellaneous tasks to maintain the 

module and support the analytics users. You will perform most or all these tasks during the 

implementation of the wInsight Analytics Module. After you make the module available to those who will 

use the analytics, the primary ongoing task is to load fresh wInsight data periodically. 

This document uses <installation location> to indicate the installation path that you selected during the 

installation of the wInsight Analytics Module. Here are the default locations. 

Folder  Default Path for Server 

Installation 

Default Path for Standalone 

Installation 

QlikView Application 

It contains the Directory 

Service Connector, 

Distribution Service, 

Examples, Management 

Service, QvPlugin, 

QvProtocol, Server, 

Support Tools, Themes, and 

Web sub-folders and 

corresponding files. 

C:\Program Files\QlikView C:\Program Files\QlikView 

wInsight Application 

It contains the bin and 

WSWebSvc sub-folders 

and corresponding files. 

C:\Program Files\Deltek\wInsight 

Analytics 

Not Applicable. The standalone 

version does not use wInsight 

Application (Web service) files. 

 

wInsight Data 

It contains the admin, 

Backups, data, Database, 

datapull, extension, final, 

Logs, publish, qvds, setup, 

Support, and translate sub-

folders and corresponding 

files. 

C:\ProgramData\Deltek\wInsight 

Analytics 

C:\Users\<User name>\My 

Documents\Deltek\Analytics 
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Security 

The wInsight Analytics Module uses security information in PPM Administration or EPM Security 

Administrator to determine who can use the module and which contracts they have access to. Because 

the module's security is based on wInsight Analytics security, you should focus on it early in the 

implementation process, particularly if wInsight Analytics security is not already in place. Also, while you 

can implement security at any time, Deltek has found that the best practice is to implement it before 

you begin loading wInsight Analytics data into the data model. 

Configuration 

wInsight Analytics includes a separate application that you use to specify the configuration settings. 

Configuration settings determine several important wInsight Analytics characteristics. They also affect 

what data is loaded into the analytics data model from the wInsight Analytics database and how that 

data is transformed for the analytics. 

Before you load wInsight Analytics data from the database into the wInsight Analytics Module data 

model the first time, you select the configuration settings. After the implementation is complete and you 

make wInsight Analytics generally available to users, changes to configuration settings should be 

minimal. Generally, once you select the initial configuration settings, you only need to change those 

settings if you decide that your original selection is not what you want or, in some cases, if data changes 

in the wInsight Analytics database. 

Data Load 

Before you can begin using the wInsight Analytics Module, you must load the initial set of wInsight 

Analytics data into the analytics data model. After you implement and begin using the wInsight Analytics 

Module, you must load data periodically to make the latest wInsight Analytics data available in the 

wInsight Analytics Module. 

When you load data from the wInsight Analytics database, the process loads all relevant data for the 

periods you specify in wInsight Analytics backup duration, including user-defined fields and calculated 

fields. 

Collaboration Tools 

If you have a server installation of wInsight Analytics, you can set up the wInsight Analytics Module so 

that analytics users can annotate the charts and tables, and others can view those annotations. And one 

analytics user can share his or her wInsight Analytics session in real time with one or more other users. 

These features are not available if you have a standalone installation of wInsight Analytics. 
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Configuration 
wInsight Analytics includes a separate application that you use to specify the configuration settings. 

Configuration settings determine several important wInsight Analytics characteristics. They also affect 

what data is loaded into the analytics data model from the wInsight Analytics database and how that 

data is transformed for the analytics. 

Before you load wInsight Analytics data from the database into the wInsight Analytics Module data 

model the first time, you select the configuration settings. You may also need to modify the information 

in the wInsight_Analytics_Setup.xlsx file in the C:\ProgramData\Deltek\Analytics\Setup folder. 

After the implementation is complete and you make wInsight Analytics generally available to users, 

changes to configuration settings should be minimal. Generally, once you select the initial configuration 

settings, you only need to change those settings if you decide that your original selection is not what 

you want or, in some cases, if data changes in the wInsight Analytics database. 

In most cases, if you make a configuration change, you can implement that change by running 

Load_wInsight_Data.bat to load data for all projects or the selected project based on the new 

configuration. 

 

Specify Configuration Options 

Use wInsight Analytics Configuration to specify the configuration options that determine important 

characteristics of the analytics, what data is loaded from the wInsight Analytics database, and how that 

data is transformed for the analytics. 

 

To specify configuration options for the wInsight Analytics Module: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, go 
to the C:\ProgramData\Deltek\Analytics\admin folder. 

2. Double-click wInsight_Analytics_Config.qvw to open wInsight Analytics Configuration. 

Note: If you make any changes to the configuration settings, it is very important that you both click 

Save Settings for wInsight Analytics and click  on the toolbar to save the current configuration 

settings before you run the data load process. If you do not do both, the data load may not use the 

most current configuration settings. 

Attention: There are two ways to load data, one is running a batch file from the server (using 

wInsight Analytics Configuration) and the other from the QlikView AccessPoint (using the Project 

Load tab). For more information, see the Data Load section in this document. 
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3. Click Update from wInsight Database. The wInsight Analytics Configuration imports data from 
the wInsight Analytics database that you need to specify configuration settings (for example, 
the list of units). 

When this process is completed, you receive a message that confirms that the wInsight 

Analytics data has been imported successfully into wInsight Analytics Configuration. 

4. Use wInsight Analytics Configuration to specify the configuration settings you want. Click  
periodically to save your work. 

5. Click Save Settings for wInsight Analytics. When this process is completed, wInsight Analytics 
displays a message that confirms that the settings have been updated successfully. 

6. If you have unsaved entries, click  to save them in wInsight_Analytics_Config.qvw. 

When you have saved the settings in wInsight Analytics Configuration, you are ready to run the process 

to load data into the analytics data model. 

wInsight Analytics Database 

Use wInsight Database to specify the type of database in which the wInsight Analytics data is stored. 

Purpose 

To extract the data from the wInsight Analytics database and load it into the analytics data model, the 

data load process needs to know what type of database you use. 

 

Initial Configuration 

In Database Type under wInsight Analytics Database, indicate if your wInsight data is stored in an Oracle, 

Microsoft SQL Server, or Microsoft Access database. 

Ongoing Administration 

Normally, you do not change this setting after the initial configuration. However, you can change it at 

any time, if you change the type of database in which wInsight Analytics data is stored. 

Current Period 

Use Current Period to specify the latest period for which you want to display wInsight Analytics data in 

the analytics. 

Purpose 

The selection in Actuals Up Through under Current Period determines the latest wInsight Analytics 

period for which data is loaded into the analytics data model. 
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 This entry and the entry in Number of Periods Back under Historical Data Load control which periods are 

loaded. For example, if you select 11-30-2015 in Actuals Up Through and select 60 in Number of Periods 

Back, the data load process loads wInsight Analytics data for the period ending on 11-30-2015 and for 

the 59 previous periods. 

In addition, this entry and the entry in Number of Versions Back under Forecast Data Load control how 

many versions of future period forecast and budget data are loaded. For example, if you select 11-30-

2015 in Actuals Up Through and select 5 in Number of Versions Back, the data load process loads 

wInsight Analytics future period forecast and budget data from the period ending on 11-30-2015 and 4 

previous periods. 

"Latest" Option 

The list of period end dates in Actuals Up Through also includes a Latest option. If you normally want to 

load data through the most recent period in the wInsight database, you can select this option. If you do 

that, you only must change this setting in the future if for some reason you want to load data for earlier 

periods but not for the most recent period. 

Current Period Option on the By Project Tab 

The By Project tab has an identical Current Period option. The two options have the same purpose but 

function independently. The option on the By Project tab only applies to the partial data loads for 

selected projects that you initiate from that tab, while the option on the wInsight Analytics 

Configuration tab only applies to full data loads that include all projects. 

Initial Configuration 

For the initial configuration, select either Latest or the end date of the latest wInsight Analytics period 

for which you want to load initial data into the analytics data model. This period need not be the latest 

period for which data exists in wInsight Analytics if you are not ready to load the most current data. 

Ongoing Administration 

If you select Latest in Actuals Up Through and you set Number of Periods Back to 1, the data load 

process automatically loads data for the latest period for which data is available in wInsight, so you do 

not normally need to change this selection from month to month. 

If you select a specific period end date instead of Latest in Actuals Up Through, you need to change the 

selected date each time you are ready to start including a new period in the data load. 
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Entering 1 in Number of Periods Back minimizes the time it takes to load the data because only one 

period's data is processed. However, if you want to load more than one period, enter the appropriate 

number in Number of Periods Back. 

If your data load includes new or updated user-defined filters, make sure that you set the options in 

wInsight Analytics Configuration so that data is loaded for all months for which you want to use those 

filters. 

Historical Data Load 

Use Historical Data Load to specify the number of past monthly periods for which you want to load data. 

Purpose 

Your entry in Number of Periods Back under Historical Data Load controls the number of historical 

wInsight Analytics periods for which data is loaded into the analytics data model when you run the data 

load process. 

 

 This entry and the entry in Actuals Up Through under Current Period control which periods are loaded. 

For example, if you select 11-30-2014 in Actuals Up Through and select 24 in Number of Periods Back, 

the data load process loads wInsight Analytics data for the period ending on 11-30-2014 and for the 23 

previous monthly periods. 

 

Historical Data Load Option on the By Project Tab 

The By Project tab has an identical Historical Data Load option. The two options have the same purpose 

but function independently. The option on the By Project tab only applies to the partial data loads for 

selected projects that you initiate from that tab, while the option on the wInsight Analytics 

Configuration tab only applies to full data loads that include all projects. 

Preparation 

In Actuals Up Through under Current Period, select the latest period for which you want to load 

wInsight Analytics data into the analytics data model. If you normally want to load data through the most 

recent period in the wInsight database, it is recommended that you select Latest rather than a specific 

period end date. 

Note: If a contract uses periods other than monthly (weekly, for example), this setting still loads the 

specified number of months of data. 
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Initial Configuration 

When you set up wInsight Analytics, you load all the historical wInsight Analytics data that you want to 

be available when you begin using the analytics. To do that, use the Number of Periods Back field under 

Historical Data Load to enter or select the number of historical periods for which you want to load data. 

For example, select 24 if you want to load data for the period selected in Actuals Up Through and for 

the 23 previous periods. 

The maximum entry is 99 but if you need to go back further, you can select an earlier period in Actuals 

Up Through, load that data, and then select a more recent period in Actuals Up Through and load the 

later data. 

Ongoing Administration 

To minimize or eliminate ongoing maintenance of this option and the related Actuals Up Through 

option, select Latest in Actuals Up Through and set Number of Periods Back to 1. If you do that, the data 

load process automatically loads data for the latest period for which data is available in wInsight, so you 

do not normally need to change either of these selections from month to month. 

Even if you prefer to specify a specific period end date in Actuals Up Through when you are ready to 

load data for a new period, you should not normally need to change the value in Number of Periods Back 

from month to month. 

Entering 1 in Number of Periods Back minimizes the time it takes to load the data because only one 

period's data is processed. However, in rare cases, you may find it necessary to load more than one 

period of new data. To do that, select the appropriate number of periods in Number of Periods Back. 

If your data load includes new or updated user-defined filters, make sure that you set the options in 

wInsight Analytics Configuration so that data is loaded for all months for which you want to use those 

filters. 

Forecast Data Load 

Use Forecast Data Load to specify the number of past periods from which you want to load future 

period forecast and budget data. 

Purpose 

Your entry in Number of Versions Back under Forecast Data Load controls the number of historical 

versions of future period forecast and budget data that are loaded into the analytics data model when 

you run the data load process. You can compare the different versions of forecasts 

and future period budgets on the Future Forecasts tab in the wInsight Analytics Module. 

This entry and the entry in Actuals Up Through under Current Period control the periods from which 

future period data are loaded. For example, if you select 11-30-2014 in Actuals Up Through and select 6 
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in Number of Versions Back, the data load process loads future period data for the period ending on 11-

30-2014 and for the 5 previous periods. 

Forecast Data Load Option on the By Project Tab 

The By Project tab has an identical Forecast Data Load option. The two options have the same purpose 

but function independently. The option on the By Project tab only applies to the partial data loads for 

selected projects that you initiate from that tab, while the option on the wInsight Analytics 

Configuration tab only applies to full data loads that include all projects. 

Preparation 

In Actuals Up Through under Current Period, select the latest period for which you want to load 

wInsight Analytics data into the analytics data model. 

Initial Configuration 

When you set up wInsight Analytics, you load all the historical versions of future period forecast and 

budget data that you want to be available when you begin using the analytics. To do that, use the 

Number of Versions Back field under Forecast Data Load to enter or select the number of periods for 

which you want to load future period data. The maximum entry is 12. 

Ongoing Administration 

To minimize or eliminate ongoing maintenance of this option and the related Actuals Up Through 

option, select Latest in Actuals Up Through and set Number of Versions Back to 1. If you do that, the 

data load process automatically loads the future period forecasts and budget data for the latest period 

for which data is available in wInsight, so you do not normally need to change either of these selections 

from month to month. 

Even if you prefer to specify a specific period end date in Actuals Up Through when you are ready to 

load future period data for a new period, you should not normally need to change the value in Number of 

Versions Back from month to month. 

Entering 1 in Number of Versions Back minimizes the time it takes to load the data because only one 

period's data is processed. However, in rare cases, you may find it necessary to load more than one 

period of new future period data (because of corrections made to the data, for example). To do that, 

select the appropriate number of periods in Number of Versions Back. 

Work Package Control Account 

Use Work Package Control Account to indicate which element types are at either the control account 

level or the work package level. 
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Purpose 

In wInsight Analytics, each firm can define element types in whatever way fits its needs. The wInsight 

Analytics Module, however, needs to use the element types to identify which elements are at the control 

account level and which are at the work package level. To make that possible, you need to use the Work 

Package Control Account settings to indicate which element types belong in each of these categories. 

 

 Initial Configuration 

When you configure the wInsight Analytics Module initially, select C in C or W next to each element type 

that is assigned to control accounts and W next to each element type that is assigned to work packages. 

Ongoing Administration 

Normally, you do not change these settings after the initial configuration. However, you can change 

them at any time. 

Unit Used as Element of Cost 

Use Unit Used as Element of Cost to identify units that wInsight Analytics should consider elements of 

cost and define the corresponding unit of measure (Dollars, Hours, or EQP) for each EOC entry. 

 

Purpose 

wInsight Analytics optionally allows Elements of Cost (EOCs) to be represented as Units in the same 

way as true Units (Hours, Dollars, etc.) to support analysis by EOC. The wInsight Analytics Module, 

however, needs to be able to distinguish between units and elements of cost so that EOCs are not 

included in the EOC Units selection lists, and units are not included in charts and tables that display EOC 

data. 
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Initial Configuration 

When you configure the wInsight Analytics Module initially, wInsight Analytics Configuration displays 

default values for each of the types of units: Y (yes) for those units it assumes are elements of cost and 

N (no) for those it assumes are not EOCs. If those defaults are correct, you do not need to make any 

entries in this table. 

When you first run wInsight Analytics Configuration, the EOC Unit column is empty by default. You need 

to specify the appropriate EOC unit for each unit identified as an EOC. You can only enter EOC units 

that match the standard units, which are displayed in the Name column (Dollars, Hours, and EQP) on 

lines flagged as units. For example, if the EOC unit of LABOR is in dollars, you need to enter Dollars, not 

Dollar. The wInsight Analytics Configuration utility does not allow you to save the wrong EOC unit. The 

application then remembers any saved settings the next time you run it. 

If one or more of the defaults are incorrect: 

1. Hover over the first EOC cell in the Unit Used as Element of Cost table that contains an 
incorrect value, and click the button displayed at the right end of the cell: 

Note: If you accidentally click in the cell rather than on the button, that action selects that row 

of the table and the other rows no longer display. If that happens, click  Clear on the toolbar to 

display all rows again. 

2. Enter Y if that wInsight unit is actually an EOC. Enter N if it is not an EOC. 

3. Use the TAB key to move to the next incorrect EOC cell, or hover and click the button in that 
cell. 

4. Repeat steps 2 - 3 for each wInsight unit for which the default value in EOC is incorrect. 

5. In the EOC Unit column of an EOC row, hover, click the button, and enter the appropriate unit. 
Only the EOC units that you define in this table are displayed on the EOC Unit table on the 
Element of Cost tab in wInsight Analytics. In addition, the unit entered for an EOC must match 
one of the true units in the table (for example, Hours or Dollars). Otherwise, an error displays on 
saving. 

Ongoing Administration 

Normally, you do not change these settings after the initial configuration. However, you can change 

them at any time (for example, if you add a new type of unit in wInsight). 

WBS OBS Link 

Use the WBS OBS Link option to indicate if you want to display the WBS OBS View analytics in wInsight 

Analytics - Multi-Project. 
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Purpose 

The WBS OBS Link option controls whether the WBS OBS View tab is available in the Multi-Project 

analytics. The primary consideration is whether the WBS-to-OBS mapping information is available in the 

wInsight Analytics database. If the required WBS-to-OBS mapping information has not been set up in 

wInsight Analytics Administrator, you cannot use the WBS OBS View tab. 

 

Initial Configuration 

When you configure the wInsight Analytics Module initially, select Y (yes) if the WBS-to-OBS mapping 

information is available in the database and you want to analyze that information in the WBS OBS View 

analytics. 

Select N (no) if the WBS-to-OBS mapping information is not available or, for some other reason, you do 

not want the WBS OBS View tab to be available. If you select N, the WBS OBS View tab is not displayed. 

(It is also not displayed if you select Y but no mapping data exists in the wInsight Analytics database. 

Ongoing Administration 

Normally, you do not change these settings after the initial configuration. However, you can change 

them at any time (for example, if you later start mapping the two structures). 
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Implement the WBS OBS View Analytics 
Before you can use the WBS OBS View tab, you must complete several prerequisite setup tasks. 

The primary prerequisite is that the wInsight database must contain the WBS-to-OBS mapping 

information. If the required WBS-to-OBS mapping information is not available in wInsight Analytics 

Administrator, you cannot use the WBS OBS View tab. In that case, either use WBS Mapper to create the 

mapping information, or leave WBS OBS Link in wInsight Analytics Configuration, set to N so that the 

WBS OBS View tab will not be displayed. 

If the required WBS-to-OBS mapping information is available, the remaining tasks basically establish a 

common set of organizations for all contracts so that the data aggregated across multiple contracts can 

be compared meaningfully. This is necessary because each contract potentially uses a different OBS in 

wInsight, so you need to define how the OBS elements from different contracts should be consolidated. 

To implement the WBS OBS View analytics: 

1. If you have not already done so, map WBS elements to OBS elements in wInsight Analytics 
Administrator. 

2. In wInsight Analytics Configuration, either wait until after the next scheduled data load process, 
or click Run Data Load Batch File to load wInsight data, including the WBS-to-OBS mapping 
information. 

This process takes some time; how long it takes depends on the size of your database and how 

many projects and periods you are loading. When it is completed, a message displays that 

confirms that the data model has been updated with the current wInsight Analytics data, based 

on your configuration settings. 

3. On the server or standalone computer on which you installed the wInsight Analytics Module, use 
Windows Explorer to go to the <installation location>\Translate folder and open 
Data_Model_wInsight.qvw. 

4. Do one of the following: 

 If you use the same OBS structure for all projects, copy the contents of the Method 1: 
Consistent OBS Mapping table. 

 If the OBS structure is not the same for all projects, copy the contents of the Method 2: 
Different OBS by Contract table. To copy the contents of either table, right-click anywhere 
on the table and click Copy to Clipboard » Table Data Area. 

5. On the server or standalone computer on which you installed the wInsight Analytics Module, use 
Windows Explorer to go to the <installation location>\Setup folder and open the 
wInsight_Analytics_Setup.xlsx file in Microsoft Excel®. 

6. On the OBS_Org_Mapping sheet, click the A2 cell and paste the data that you copied from the 
table in Data_Model_wInsight.qvw. 

7. Do one of the following: 



 

Administration Guide 13 

 

 If you use the same OBS structure for all projects, copy the contents of the OBS Name 
column of the spreadsheet and paste that in the Mapped Organization column. Make sure 
that the Contract Name column is empty for all rows. 

 If the OBS structure is not the same for all projects, use the Mapped Organization column to 
enter the organization to which you want to map data for each project- specific OBS code. 
The goal is to define a common set of organizations to which all project-specific OBS codes 
are mapped. For example, if E400 for Project A is equivalent to ENG111 for Project B, you 
could enter Engineering for both of those rows to map data for those two OBS codes to a 
single organization in the WBS OBS View analytics. If you use this method, you must make 
an entry in Mapped Organization for every row in the spreadsheet. 

The names in the Mapped Organization column display on the WBS OBS View tab when you 

display data at the lowest OBS level. 

8. Save the wInsight_Analytics_Setup.xlsx file. 

9. Go to the Org_Hierarchy sheet. 

10. In Mapped Organization, enter or copy-and-paste each of the organization names you set up in 
the Mapped Organization column on the OBS_Org_Mapping sheet. Each name should only 
appear once on this sheet. 

11. Determine how you want to roll up the OBS data from the level defined in the Mapped 
Organization column to two higher levels of organizational elements. 

12. In Higher Level, enter the name of the second-level organizational element to which you want to 
assign each organization in Mapped Organization. To roll up multiple organizations in Mapped 
Organization into one second-level organizational element for analysis purposes, enter the same 
organizational element name for each organization. 

13. In Top Level, enter the name of the top-level organizational element to which you want to assign 
each organization in Mapped Organization. To roll up multiple organizations in Mapped 
Organization into one top-level organizational element for analysis purposes, enter the same 
organizational element name for each organization. 

14. Save the wInsight_Analytics_Setup.xlsx file. 

15. On the wInsight Analytics Configuration tab of the Configuration application, select Y (yes) in 
WBS OBS Link to activate the WBS OBS View tab. 

16. Click Save Settings for wInsight Analytics. 

When this process is completed, wInsight Analytics displays a message that confirms that the 

settings have been updated successfully. 

17. Click   on the toolbar to save the setting in wInsight_Analytics_Config.qvw. 

 

Important: If you make any changes to the configuration settings, it is very important that you both 

click Save Settings for wInsight Analytics and click   on the toolbar to save the current configuration 

settings before you run the data load process. If you do not do both, the data load may not use the 

most current configuration settings. 
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The next time that the data load process runs, the data model and the Multi-Project Analytics user 

interface are updated to reflect the WBS-to-OBS mapping implementation. You can wait for your next 

scheduled data load process, or you can click Run Data Load Batch File on the wInsight Analytics 

Configuration tab of the Configuration application to run it yourself. To verify the implementation 

without having to run the data load process, open wInsight_Analytics_MultiProject.qvw in Qlikview for 

Windows and click File » Reload. The wInsight_Analytics_MultiProject.qvw file is in the <installation 

location>\Final folder. 

Override Period End Dates 

By default, wInsight Analytics assigns periods to a month based on each period's end date. However, if 

you have a period that starts in one month and ends early in the next, it is likely that assigning that period 

to a month based on the end date would be incorrect. If you have contracts for which this situation 

exists, you can use the wInsight_Analytics_Setup.xlsx Microsoft Excel® spreadsheet to map those 

periods to end dates in the correct months. 

For example, if a contract calendar has a period with a 3/02/2013 end date, the data load process, by 

default, assigns that period to the March monthly period for analysis, but that data probably should be 

considered February data. 

To map selected period end dates to months other than the default months: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, use 
Windows Explorer to go to the <installation location>\Setup folder. 

2. Open the wInsight_Analytics_Setup.xlsx file in Microsoft Excel. 

3. In Windows Explorer, go to the <installation location>\Admin folder. 

4. Run wInsight_Analytics_Config.qvw to open wInsight Analytics Configuration. 

5. Click the wInsight Analytics Utility tab. 

6. Click n the upper-right corner of the Export Period EndDate list. The list of period end dates is 
displayed in Microsoft Excel. 

7. Select and copy all of the period end dates, and paste them in the End Date column on the 
EndDate_Override sheet in the wInsight_Analytics_Setup.xlsx file. 

For each period end date that needs to be overridden to associate it with the correct monthly 

period, enter a date from the correct month (the last day of the month for example) in the End 

Date Override column. For period end dates that do not need to be overridden, you can leave 

the End Date Override column blank. 

8. Save the wInsight_Analytics_Setup.xlsx file. 

9. On the wInsight Analytics Configuration tab of the Configuration application, make sure the 
Current Period and Historical Data Load options are set to include all the periods for which you 
need to load data. 

10. Click Save Settings for wInsight Analytics. When this process is completed, wInsight Analytics 
displays a message that confirms that the settings have been updated successfully. 
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11. If you have unsaved entries, click  to save them in wInsight_Analytics_Config.qvw. 

Important: If you make any changes to the configuration settings, it is very important that you 

both click Save Settings for wInsight Analytics and click  on the toolbar to save the current 

configuration settings before you run the data load process. If you do not do both, the data load 

may not use the most current configuration settings. 

When you have saved the settings in wInsight Analytics Configuration, you are ready to run the process 

to load data into the analytics data model. That process will use the period end date override information 

you entered to assign those periods to monthly periods in the analytics data model. 

 

Load Additional Fields 

For the most part, the data load process loads all fields from several key tables related to earned value 

performance that are referenced in the ColumnN table. However, standard analytics do not use some of 

those fields so, by default, they are excluded from the data load to reduce the size of the data model. If 

you decide that you would like any of those fields to be available in the analytics data model, you can 

override the decision to exclude them on a field-by-field basis. 

To review the list of fields that are excluded by default, open the wInsight_INTERNAL.xlsx file and go to 

the Fields_To_Bring_In sheet. The wInsight_INTERNAL.xlsx file is in the <installation location>\Translate 

folder. 

To include fields in the data load that are excluded by default: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, use 
Windows Explorer to go to the <installation location>\Translate folder. 

2. Open the wInsight_INTERNAL.xlsx file in Microsoft Excel®. 

3. Go to the Fields_To_Bring_In sheet. 

4. For each field that you want to include in the data load process, enter Y in Bring In (Y/N). 

5. Save the wInsight_INTERNAL.xlsx file. 

6. On the wInsight Analytics Configuration tab of the Configuration application, make sure the 
Current Period and Historical Data Load options are set to include all the periods for which you 
want to load data for the newly included fields. 

7. Click Save Settings for wInsight Analytics. 

Note: If you only have a few period end dates to override, you do not have to export all of your end 

dates to Excel and then copy them into wInsight_Analytics_Setup.xlsx. You can just open 

wInsight_Analytics_Setup.xlsx, manually enter each of those dates in End Date, and enter the 

override dates in End Date Override. The spreadsheet only needs to contain the period end dates 

you want to override. 
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When this process is completed, wInsight Analytics displays a message that confirms that the 

settings have been updated successfully. 

8. If you have unsaved entries, click  to save them in wInsight_Analytics_Config.qvw. 

 

When you have saved the settings in wInsight Analytics Configuration, you are ready to run the process 

to load data into the analytics data model. That process will include the fields that you selected for 

inclusion. 

Manage Data Validation Checks 

By default, wInsight Analytics applies a standard set of validity checks to the data for the period you 

select and alerts you to errors, warnings, unrealistic forecasts, or other conditions of interest. However, 

you can control which of the available validation checks your firm will use. You can also assign the 

validation checks to different validation types, rename validation types, modify validation check 

descriptions, or add entirely new validation checks. 

To review the list of default data validation checks, open the wInsight_Analytics_Setup.xlsx file and go to 

the Data_Validation sheet. The wInsight_Analytics_Setup.xlsx file is in the 

<installation location>\Setup folder. 

 

To disable a data validation check or to make changes or additions to data validation check 

information: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, use 
Windows Explorer to go to the <installation location>\Setup folder. 

2. Open the wInsight_Analytics_Setup.xlsx file in Microsoft Excel®. 

3. Go to the Data_Validation sheet. 

4. If you are making changes to an existing data validation check, scroll to that row. If you are 
adding a new data validation check, scroll to the first empty row or insert a blank row. 

5. To change the validation type to which a validation check is assigned, enter the validation type 
in RiskType, change the validation type to which a validation check is assigned, enter the 
validation type in RiskType. To add a new validation type, enter it in RiskType for one or more 
validation checks. 

Important: If you make any changes to the configuration settings, it is very important that you both 

click Save Settings for wInsight Analytics and click  on the toolbar to save the current 

configuration settings before you run the data load process. If you do not do both, the data load may 

not use the most current configuration settings. 

Note: Before you make any changes to the data validation check information, Deltek recommends 

that you back up the original spreadsheet. 
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6. To change the description of a validation, check that appears on the Data Validation tab, edit the 
description in RiskDesc. 

7. If you are adding a new validation check, enter a unique ID in RiskID. 

8. To change the validation expression, edit the information in Validation 

Any fields that you reference in the expression must exist in the EarnedValue table in wInsight 

and must have been included in the wInsight Analytics Module data model. 

9. To change the set of fields that are displayed in the Validation table on the Data Validation tab 
when the validation check returns an alert for an element, edit the comma- delimited list in 
FieldList. 

Any fields that you reference in FieldList must exist in the EarnedValue table in wInsight and 

must have been included in the wInsight Analytics Module data model. 

10. To disable a data validation, check so that it is not applied to your data and does not appear on 
the Data Validation tab, enter Y in Disabled (Y/N). 

11. Save the wInsight_Analytics_Setup.xlsx file. 

12. On the wInsight Analytics Configuration tab of the Configuration application, make sure the 
Current Period and Historical Data Load options are set to include all of the periods for which 
you want to apply the modified or new data validation checks. 

13. Click Save Settings for wInsight Analytics. 

When this process is completed, wInsight Analytics displays a message that confirms that the 

settings have been updated successfully. 

14. If you have unsaved entries, click  to save them in wInsight_Analytics_Config.qvw. 

 

When you have saved the settings in wInsight Analytics Configuration, you are ready to run the process 

to load data into the analytics data model. That process will apply the modified or new data validation 

checks to the data for the period included in the data load. 

Important: If you make any changes to the configuration settings, it is very important that you both 

click Save Settings for wInsight Analytics and click  on the toolbar to save the current 

configuration settings before you run the data load process. If you do not do both, the data load may 

not use the most current configuration settings. 



 

Administration Guide 18 

 

Data Load 
The data in the wInsight Analytics Module data model is loaded periodically from the main wInsight 

Analytics database. 

 

Data Load Overview 

Before you can begin using the wInsight Analytics Module, you must load the initial set of wInsight 

Analytics data into the analytics data model. After you implement and start using the wInsight Analytics 

Module, you must load data periodically to make the latest wInsight Analytics data available in the 

analytics. 

wInsight Analytics Data 

Before you load the data the first time, use wInsight Analytics Configuration to specify and save the 

configuration settings you want. When you load data from the wInsight Analytics database, the process 

loads all relevant data for the periods you specify in wInsight Analytics Configuration, including user-

defined fields and calculated fields. The data load process also loads the views and user-defined filters 

that have been included in the .ini file in the wInsight Analytics setup folder. 

 

There are two ways to load data, one is running a batch file from the server (using wInsight Analytics 

Configuration) and the other from the QlikView AccessPoint (using the Project Load tab). 

 

When to Load wInsight Analytics Data 

Normally, you load data into the wInsight Analytics data model at the following times: 

 As part of the implementation of the wInsight Analytics Module, to load the initial set of data 

Note: The locations specified in this section refer to the default installation locations. If you installed 

the wInsight Analytics Module in a different location, go to the respective folders in your installation 

location. 

Note: If you make any changes to the configuration settings, it is very important that you both click 

Save Settings for wInsight Analytics and click  on the toolbar to save the current configuration 

settings before you run the data load process. If you do not do both, the data load may not use the 

most current configuration settings. 

Attention: For more information, see the Load Data from the Server and Load Data from the 

QlikView AccessPoint sections. 
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 On whatever regular schedule works best for your wInsight Analytics users (for example, nightly) 

Load Data from the Server 

You have the option to load data for all projects or the selected project from the server. Most firms load 

data for all projects on a regular schedule (for example, nightly). However, most also need the ability to 

load data for the selected project from time to time. For example, if you notice issues with the data 

loaded for one project after a full data load and want to reload that data after correcting it in wInsight 

Analytics or Cobra, you can select just that project for processing to make the corrected data available 

quickly to your analytics users. 

 

Delete Existing. QVD Files Before Loading Data for All Projects 

To prevent any potential errors, you must delete existing QVD files before loading data for all projects 

(full load). To delete the .QVD files, run DeleteQVDs.bat. If this is the first time you are loading data for 

all projects, you do not need to perform this task. 

By default, the DeleteQVDs.bat file is installed in C:\ProgramData\Deltek\Analytics\admin 

Data Load Programs 

wInsight Analytics provides the .bat files described below for loading and updating data from the server. 

These .bat files are located in the C:\ProgramData\Deltek\Analytics\admin folder by default. 

 

Program Description 

Load_wInsight_Data.bat 
This process loads data either for all projects (full data load) or the 

selected project, depending on which tab of 

wInsight_Analytics_Config.qvw you start the process. 

To run this file, click Run Data Load Batch File (for all projects) on the 

wInsight Analytics Configuration tab or Run Data Load By Project 

Batch File (for the selected project) on the By Project tab. 

This file does the following tasks: 

Attention: If you want to load data for all projects from the server, see the Load Data for All Projects 

section. If you want to load data for the selected project, see the Load Data for the Selected Project 

section. 

Note: To run the .bat files to load data, you must log on to the wInsight Analytics server or 

standalone computer as the DeltekAnalytics user or as another QlikView-licensed user that you have 

set up. 
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Program Description 

 Updates the wInsight Analytics data model, based on your 
configuration and security settings. 

 Loads additional setup information from the 
wInsight_Analytics_Setup.xlsx file in the 
C:\ProgramData\Deltek\Analytics\setup folder by default. 

 Loads views and user-defined filters from a copy of the 
WSCUSTOM.xml file. 

Load_winsight_data_with_Ac

umen.bat 
Deltek recommends that you run this if you are using Acumen 

functionality and exporting. DCDE data from Acumen into wInsight 

Analytics.  

This process loads wInsight data and Acumen metric data and wInsight 

data for all projects. 

Load_wInsight_Data_ 

without_Datapull.bat 

This process is the same as Load_wInsight_Data.bat except that it does 

not load data from the wInsight Analytics database and loads data for 

all projects. 

Load_Acumen_Only.bat 
This process loads data from the wInsight Analytics database into the 

wInsight_Metrics.QVW file for all projects.  

The data that it loads consists of control account and work package 

originally from Cobra, task data from a scheduling system, and metrics 

defined and calculated in Acumen. This data resides in the wInsight 

Analytics database and is the result of importing a .DCDE file, which 

has been exported from Acumen. 

 

Who Can Load Data 

wInsight Analytics provides no internal security for the configuration applications or the data load .bat 

files. Be sure that only the appropriate persons have access to the network folders or standalone 

computer folders in which you installed the wInsight Analytics Module. 

Load Data for All Projects 

This process corresponds to selecting the Load All Projects option in QlikView AccessPoint. 

Note: If you want to load views and user-defined filters, copy the current WSCUSTOM.xml file from 

wInsight to the C:\ProgramData\Deltek\Analytics\Setup folder. If you load new or updated filters, 

make sure that you set the options in wInsight Analytics Configuration so that data is reloaded for all 

months for which you want to use those filters. 
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To load data for all projects: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, log 
on as the DeltekAnalytics user or as another QlikView-licensed user that you have set up. 

2. Double-click wInsight Analytics Configuration, which is in the 
C:\ProgramData\Deltek\Analytics\admin folder by default. 

3. Review the configuration settings on the wInsight Analytics Configuration tab to make sure they 
are correct. 

4. Set the values in Current Period, Historical Data Load, and Forecast Data Load on the wInsight 
Analytics Configuration tab to determine which periods are included. 

5. Click  , and click Save Settings for wInsight Analytics. 

6. Click Run Data Load Batch File. This process takes some time; how long it takes depends on the 
size of your database and how many projects and periods you are loading. When it is completed, 
a message displays confirming the data model has been updated with the current wInsight 
Analytics data, based on your configuration settings.  

7. If you want to load views and user-defined filters, copy the current WSCUSTOM.xml file from 
wInsight to the C:\ProgramData\Deltek\Analytics\Setup folder. If you load new or updated 
filters, make sure that you set the options in wInsight Analytics Configuration so that data is 
reloaded for all months for which you want to use those filters. 

8. This step is not necessary to update user-defined filters. It is only required for views. If you load 
new or updated views, take the following actions: 

a. In QlikView for Windows, open wInsight_Analytics.qvw. The file is in the 
C:\ProgramData\Deltek\Analytics\final folder by default. 

b. Click File » Reload. 

c. Save the file. 

d. Repeat steps a – c for wInsight_Analytics_MutliProject.qvw. 

Load Data for the Selected Project 

To load data for the selected project: 

1. On the server or standalone computer on which you installed the wInsight Analytics Module, log 
on as the DeltekAnalytics user or as another QlikView-licensed user that you have set up. 

2. Double-click wInsight Analytics Configuration. 

3. Review the configuration settings on the wInsight Analytics Configuration tab to make sure they 
are correct. 

4. On the By Projects tab, set the values in Current Period, Historical Data Load, and Forecast 
Data Load on that tab to determine which periods are included. 

5. Click , and click Save Settings for wInsight Analytics. 

6. Click Run Data Load By Project Batch File. This process takes some time; how long it takes 
depends on the size of your database and how many projects and periods you are loading. When 
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it is completed, a message displays confirming the data model has been updated with the 
current wInsight Analytics data, based on your configuration settings. 

7. If you want to load views and user-defined filters, copy the current WSCUSTOM.xml file from 
wInsight to the C:\ProgramData\Deltek\Analytics\Setup folder. If you load new or updated 
filters, make sure that you set the options in wInsight Analytics Configuration so that data is 
reloaded for all months for which you want to use those filters. 

8. This step is not necessary to update user-defined filters. It is only required for views. If you load 
new or updated views, do the following: 

a. In QlikView for Windows, open wInsight_Analytics.qvw.  

b. Click File » Reload. 

c. Save the file. 

Schedule the Data Load Process 

If you install the wInsight Analytics Module and you want to load data for all projects automatically on a 

set schedule, use the Task Scheduler in Windows to set up the corresponding scheduled task manually 

for the Load_wInsight_Data.bat file.  

Set Up a Scheduled Task 

If you wish to see the batch file run, select the Run only when user is logged on option on the General 

tab. 

To set up the scheduled task: 

1. Click Control Panel » Administrative Tools and double-click Task Scheduler » Task Scheduler 
Library. 

2. On the Task Scheduler dialog box, create a scheduled task by clicking Actions »Create a Task. 

3. On the Create Task dialog box, enter DeltekwInsightAnalyticsReload in the Name field on the 
General tab. 

4. On the Actions tab, click New to create a Start a program action. 

5. In the Program/script field, enter the path and file name of the Load_wInsight_Data.bat file. For 
example, C:\ProgramData\Deltek\Analytics\admin\Load_wInsight_Data.bat. 

6. In the Start in (optional) field, enter the complete path to the folder containing the .bat file (for 
example, C:\ProgramData\Deltek\Analytics\admin), and click OK. 

7. On the Triggers tab, click New and set the schedule for the task. Make sure the Enabled 
checkbox is selected. 

8. Click OK. 

9. Click OK again. 
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Load Data from the QlikView AccessPoint 

wInsight Analytics allows you to perform loading data for of all projects or the selected project directly 

from the wInsight Analytics Module via QlikView AccessPoint. You can only run this load data process if 

you have appropriate rights. In this method, you do not need access to the server or a QlikView 

Standalone installation. Before loading all projects the first time, however, make sure the configuration 

settings have been completed and saved. 

 

 

Project Load Tab in wInsight Analytics – Single Project 

You can only use the Project Load tab if you have appropriate rights, which your administrator sets in the 

PPM Administrator or EPM SA.  

 

To access this tab, in QlikView for Windows, open wInsight_Analytics.qvw and click Project Load.  

Run Data Load for All Projects from QlikView AccessPoint 

Use this procedure to run data load for all projects directly from the wInsight Analytics database into the 

wInsight Analytics - Single Project. You can also use this procedure to load DCMA EVAS metrics from 

Acumen for all projects. 

Important: If you are using an Access database, make sure that the database and wInsight Analytics 

Module are installed on the same server. 

If you decide to run the first full data load from QlikView AccessPoint and not from the server, you 

need to run the SetWebServicesURL.bat file after the QlikView for Windows has been licensed so 

that when wInsight_Analytics.qvw is opened for the first time in QlikView AccessPoint, the Project 

Load page has the Web services URL already set. 

Note: A Cookie Settings dialog box displays the first time you access the wInsight Analytics Module 

via QlikView AccessPoint, explaining that necessary authentication cookies are stored temporarily 

and either deleted when the browser closes or retained for future sessions, depending on your 

browser settings. Click OK to continue using wInsight Analytics Module without interruption. 

Cookie deletion and retention depend on how your browser is configured. If your browser is set to 

clear cookies when it closes, or if you switch to a different browser and access the wInsight 

Analytics Module (via QlikView AccessPoint) for the first time, the Cookie Settings dialog box 

displays again. 

Attention: For more information, see the Deltek PPM Administrator Online Help or Deltek EPM 

Security Administrator Online Help. 
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To run data load for all projects from QlikView AccessPoint:  

1. On the Master Dashboard tab, select a contract in the Contract list.  

2. On the Project Load tab, select the Load All Projects.  

3. If you are loading all projects the first time, enter the Web Service URL, which you set up during 
the wInsight Analytics Module installation, and click Connect. 

4. Review the values or select the appropriate values from the drop-down lists or options to define 
the data that you need to load.  

Drop-Down List/Option Description 

wInsight Database Select the type of database where wInsight Analytics data is 

stored. 

Current Period  Select the latest period you want to load data for. 

Historical Data Load  Select the number of past monthly periods for which you want 

to load data. 

Forecast Data Load  Select the number of past periods from which you want to load 

future period forecast and budget data. 

Work Package Control 

Account 

Use this table to indicate which element types are at either the 

control account level or the work package level. 

Unit Used as Element of 

Cost  

Use this table to identify units that wInsight Analytics should 

consider elements of cost and define the corresponding unit of 

measure (Dollars, Hours, or EQP) for each EOC entry. 

Apply Security  Select this option to apply the security set up in PPM 

Administrator or EPM SA to the wInsight Analytics Module and 

load the security information into the data model. 

WBS OBS Link  Select this option if you want to display the WBS OBS View 

analytics in wInsight Analytics – Multi-Project. 

# of Levels of WBS to 

Support 

Select the amount of detail that is loaded into the wInsight 

Analytics Module if your wInsight database is very large. 

Note: Selecting this method is the same as clicking the Run Data Load Batch File button on the 

wInsight Analytics Configuration tab of wInsight_Analytics.Config.qvw from the server. 
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Drop-Down List/Option Description 

Update from wInsight 

Database 

Click this button to import data from the wInsight Analytics 

database that you need to specify configuration settings (for 

example, the list of units). 

Load Metrics Select this option to load metrics for all projects. It is the same 

as running the Load_wInsight_data_with_Acumen.bat file found 

in the C:\ProgramData\Deltek\Analytics\admin folder. 

Delete QVDs Select this option to delete existing QVD files before performing 

a full data load to prevent any potential errors. If this is your first 

time to run a full load, you do not need to select this option. 

5. Click Save Settings to save the current configuration settings before you run the data load 
process. 

6. When you are done, click the Run Data Load button. You can view the status of the load process 
in the Data Load Status field below. 

Run Data Load for the Selected Project from QlikView AccessPoint 

Use this procedure to run data load for the selected project directly from the wInsight Analytics 

database into the wInsight Analytics - Single Project. The Load Selected Project option, however, only 

becomes enabled after initially running Load All Projects. 

 

To run data load from QlikView AccessPoint:  

1. On the Master Dashboard tab, select a contract in the Contract list.  

2. On the Project Load tab, select the Load Selected Project option.  

3. Review the values or select the appropriate values from the drop-down lists or options to define 
the data that you need to load. 

Drop-Down List/Option Description 

Current Period  Select the latest period you want to load data for. 

Historical Data Load  Select the number of past monthly periods for which you want 

to load data. 

Note: Selecting this method is the same as clicking the Run Data Load By Project Batch File button 

on the By Project tab of wInsight_Analytics.Config.qvw from the server. 
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Drop-Down List/Option Description 

Forecast Data Load  Select the number of past periods from which you want to load 

future period forecast and budget data. 

4. When you are done, click Run Data Load. You can view the status of the load process in the 
Data Load Status field below. 

Permanent Exclude Projects from the Data Load 

If your core wInsight Analytics database includes projects for which you never want to load data into the 

wInsight Analytics Module data model, you can set them up so that they are always excluded. 

For example, some firms set up projects in wInsight Analytics so that they can track performance for 

both weekly and monthly periods. In the wInsight Analytics Module, however, they are only interested in 

the monthly data. 

In wInsight Analytics Administrator 7.0.1, an AnalyticsLoad column was added to the Contracts table. 

The value in AnalyticsLoad for a contract controls whether it is eligible to be included in the data load 

process. By default, that column contains Y (Yes) for all contracts. 

If you want to exclude a project from the data load process, set AnalyticsLoad to N for that contract in 

wInsight Analytics Administrator. Alternatively, you can use the database query tools for your core 

wInsight Analytics database to change the value of AnalyticsLoad to N for that contract in the ColumnN 

table. 
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Security for the wInsight Analytics Module 
The wInsight Analytics Module uses security information in PPM Administrator or EPM SA to determine 

who can use the module and which contracts they have access to. The EPM SA tool is installed when 

you install wInsight Analytics Administrator. 

Enable Security 

Security in the wInsight Analytics Module is based on security set up in PPM Administrator or EPM SA. 

To enable security, select Windows in the Authentication Mode field in your security tool. This option 

requires users to use Windows Authentication when logging on to the application, which is the 

supported authentication by wInsight Analytics Module. 

 

After enabling security in PPM Administrator or EPM SA, run the data load process in wInsight Analytics 

Module.  

 

Setting Up Users 

If security is enabled for the wInsight Analytics Module, the data load process loads all wInsight 

Analytics users who are set up for Windows authentication, whether those users are domain users or are 

set up for Windows authentication on the wInsight Analytics server. The wInsight Analytics Module does 

not support access for users who are not set up for Windows authentication. 

To add a new module user, set that person up in wInsight Analytics as a Windows authentication user, 

and give them the appropriate access to contracts. Then run the data load process to add their access 

information to the analytics data model. 

 User Authentication 

When a person runs the wInsight Analytics Module, Windows authentication determines whether they 

gain access to the module. 

  

Attention: For more information, see the Deltek PPM Administrator Online Help or Deltek EPM 

Security Administrator Online Help. 

Attention: For more information, see the Data Load Overview section. 
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Access to Contracts 

A wInsight Analytics user is granted access to contracts either individually or through a user group. The 

data load process loads that access information into the analytics data model. In most cases, a user 

automatically has access to data for the same set of contracts in the wInsight Analytics Module as he or 

she does in wInsight Analytics. 

Users Created During Installation 

The two administrative users created during the installation process (DeltekAnalytics and 

DelteAnalyticsCW) are not automatically users within the wInsight Analytics database and have no 

automatic access to projects within the database. If security is turned on in wInsight Analytics then a 

person logged in using one of these user names would not see any projects after loading data. These 

users can either be added to the wInsight Analytics database or wInsight Analytics security can be 

turned off in PPM Administrator or EPM SA while the initial data load is run and checked before being 

turned back on for production purposes. 

Security for wInsight Analytics Configuration 

wInsight Analytics provides no internal security for the configuration applications and related 

administrative files. Be sure that only the appropriate people have access to the network or standalone 

computer folders in which you installed wInsight Analytics. 

If you are loading data using wInsight_Analytics_Config.qvw, the Apply Security setting in the Security 

section on the wInsight Analytics Configuration tab indicates whether you want to use wInsight 

Analytics Module security and save the security status (whether you set Apply Security to Yes), which 

wInsight_Analytics.qvw uses in the authentication process. 
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wInsight Web Services 
wInsight Analytics Web services are the underlying mechanism required to support a number of wInsight 

Analytics capabilities including Narrative entry and the displaying of Gantt charts, wInsight Analytics 

reports, and wInsight Analytics charts. 

wInsight Analytics Web Services Overview 

wInsight Analytics Web Services communicate over the SOAP (Simple Object Access Protocol) 

Protocol. The interface to the wInsight Analytics Web Services are described by its WSDL (Web Service 

Description Language), which is a XML document that specifies the location and operations the service 

exposes. The wInsight Analytics Web Services are published with the UDDI (Universal Discovery 

Description and Integration) protocol which enables applications to look up and find the wInsight 

Analytics Web Services. 

Enable Required .NET Framework Features  

Before running the wInsight Analytics Module web services, make sure the following .NET features are 

enabled on your Windows Server. Enabling these Windows Features is a separate and required step from 

installing .Net Framework 4.8. 

 Enable .NET Framework 3.5 

 NET 3.5 must be explicitly turned on as a Windows Feature because it installs a separate runtime (CLR 

2.0) that is not included by default. QlikView Server and its components — including QlikView 

Management Console (QMC), AccessPoint, and QlikView services — were built on this runtime and will 

not load without it. 

 Enable .NET Framework 4.7 Features 

Installing the .NET 4.8 runtime and enabling the .NET Framework 4.7 Windows Feature are two different 

things. The .NET Framework 4.7 Features entry in Add Roles and Features controls critical IIS integration 

components — including ASP.NET 4.7 and WCF HTTP Activation — that are required for .NET 4.x 

services to run correctly. Installing .NET 4.8 upgrades the runtime but does not automatically enable 

these feature entries, so they must be turned on manually. 

To enable these features: 

1. On your Windows Server, open Server Manager. 

2. In Server Manager, click Manage, then select Add Roles and Features. 

3. Select Role-based or feature-based installation and click Next. 

4. Select your server from the server pool and click Next. Skip the Server Roles screen by clicking 

Next again. 
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5. On the Features screen, locate and expand the following: 

 .NET Framework 3.5 (includes .NET 2.0 and 3.0) 

 .NET Framework 4.7 Features (including ASP.NET 4.7 and WCF Services » HTTP 

Activation) 

6. Click Next through the remaining screens, then click Install. Wait for the installation to complete. 

7. Once the installation is complete, click Close. 

Add the wInsight Analytics Web Services Test Tab 

The Web Services Test tab does not display in wInsight Analytics Module by default. You need to add it 

to the view using QlikView for Windows. 

 

To add the Web Services Test tab to the view: 

1. In QlikView for Windows, double-click wInsight_Analytics.qvw. This file is located in the 
<installation location>\Final folder. 

2. On the View menu, verify that WebView is turned on. 

3. Click  to create the new sheet. 

4. On the new sheet, right-click anywhere and then select New Sheet Object. 

5. In the Extension Objects list, select wInsightWebServicesTest and drag it onto the sheet. 

 

Note: The Web service must be deployed on the same machine with the same port as QlikView. If a 

client wants to deploy the Web service to a different port on the same machine or a different 

machine, the client's IT team will be responsible for configuring the Web server with the necessary 

IIS settings. 
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Narrative Input Template 
wInsight Analytics Module allows you to create custom narrative input templates that it can use for all 

wInsight Analytics Module contracts. 

Custom Narrative Input Template Overview 

wInsight Analytics Module uses several input templates for the narrative that each template supports. 

These input templates are stored in the <installation location>\bin\ folder. 

File Name Description 

Eacnarr_template.htm Element EAC Narrative 

Fmt5_template.htm Format 5 Narrative 

Tripwirenarr_template.htm Program Tripwires Summary 

Sow_template.htm Scope of Work 

Usernarr_template.htm User Narrative 

Create a Custom Narrative Input Template 

Use this procedure to create a custom narrative input template that is used for all wInsight Analytics 

Module contracts. 

To create a custom narrative input template: 

1. Use an HTML editor, such as Microsoft FrontPage, to edit the appropriate template. 

2. Add the appropriate fields to the desired narrative input template. To determine the wInsight 
Analytics field name, proceed to step 3. Otherwise, skip the next step and proceed to step 4. 

3. On the wInsight Desktop menu, click Options » Column » Insert. In the Column Definition dialog 
box, review the items in the drop-down list, and then return to the HTML editor. 

4. Save your changes. 

5. Close the HTML editor. 

Add a wInsight Analytics Contract Name to a Template Name 

wInsight Analytics Module supports contract-specific narrative input templates. This is accomplished by 

adding the wInsight Analytics contract name to the beginning of a template name (for example, MOH-

2_fmt5_template.htm). The added contract-specific narrative input template must be stored in the 

wInsight Analytics bin folder, which default location is <installation location>\bin\. 
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To add the contract name to the beginning of a template name: 

1. Make a copy of the desired template identified above. 

2. Modify it by following the steps in the Create a Narrative Input Template section. 

3. Add the contract name to the beginning of the filename, followed by an underscore. For 
example, for the MOH-2 contract the template name would be MOH-2_FMT5_TEMPLATE.HTM. 
If there are spaces in the contract name, there should be spaces in the input template name. 
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Collaboration 
If you have a server installation of wInsight Analytics, you can take advantage of two powerful 

collaboration tools: annotations and session collaboration. 

Notes and Session Collaboration Overview 

If you have a server installation of wInsight Analytics, analytics users can annotate the charts and tables, 

and others can view those annotations. And one analytics user can share his or her wInsight Analytics 

session in real time with one or more other users. 

These features are not available if you have a standalone installation of wInsight Analytics. Notes Feature 

If you enable the Notes feature, wInsight Analytics users can attach their own notes to charts, tables, or 

lists. They can also take a snapshot of the analytics and save it along with the note to provide context. 

Other users with access to the analytics can display those notes, use the snapshot to view the analytics 

as they appeared when the note was saved, and add their comments to the notes, including their own 

snapshot of the data. 

The snapshot option for notes is similar in some ways to the bookmark feature. However, while the 

bookmark is intended to provide a way to save a view that you want to return to on a regular basis, the 

snapshot provides a quick way to capture a view temporarily to enhance a specific discussion of the 

data and then be discarded. 

Session Collaboration Feature 

If you enable the Session Collaboration feature, users connected to the wInsight Analytics server and 

using the Full Browser client can invite others to share their wInsight Analytics session for collaboration 

purposes. Any of those sharing the session can interact with the analytics, and all others in the session 

immediately see the results of that interaction on their laptop or mobile device. Those invited to share a 

session must have access to the wInsight Analytics server but need not be licensed to use wInsight 

Analytics. 

You enable collaboration for each set of analytics individually. For example, you could enable it for 

wInsight Analytics - Multi-Project but not for wInsight Analytics – Single Project. 

 

Implement the Session Collaboration Feature 

Use QlikView Management Console to implement the Session Collaboration feature. If you enable this 

feature, users connected to the wInsight Analytics server and using the Full Browser client can invite 

others to share their wInsight Analytics session for collaboration purposes. Any of those sharing the 

Note: The Session Collaboration feature is not available to those using the Internet Explorer plugin 

client. 
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session can interact with the analytics, and all others in the session immediately see the results of that 

interaction. 

The Session Collaboration feature is not available to those using the Internet Explorer plugin client. You 

must use the Full Browser client. 

To implement the Session Collaboration feature: 

1. Run QlikView Management Console. 

2. Click the System tab and the Setup subtab. 

3. In the left pane, expand QlikView Servers, and select the wInsight Analytics server. 

4. In the right pane, click the Documents tab. 

5. Select Allow Session Collaboration. 

6. Click Apply. 

7. At the top of the QlikView Management Console, click the Documents tab and the User 
Documents subtab. 

8. In the left pane, select the first set of analytics for which you want to enable collaboration. 

9. In the right pane, click the Server tab and the Availability subtab. 

10. Select Session Collaboration. 

11. Click Apply. 

12. To enable collaboration for more sets of analytics, select each one and repeat steps 10 –11. 

Implement the Notes Feature 

Use QlikView Management Console to implement the Notes feature. If you enable the Notes feature, 

wInsight Analytics users can attach their own notes to charts, tables, or lists. They can also take a 

snapshot of the analytics and save it along with the note to provide context. 

To implement the Notes feature, complete the following steps: 

1. Run QlikView Management Console. 

2. Click the System tab and the Setup subtab. 

3. In the left pane, expand QlikView Servers, and select the wInsight Analytics server. 

4. In the right pane, click the Documents tab. 

5. Select Allow Server Annotations. 

6. Click Apply. 
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Additional Administration Topics and 
Notes 
This section contains additional topics and miscellaneous notes of interest to a system administrator. 

Lease a License from the Server for QlikView for Windows 

If you install the wInsight Analytics Module on a server and you need to set up additional users with 

access to the analytics from QlikView for Windows, each of those users must lease a license from the 

server. 

Note also that if you do not open any .QVW files on the server using QlikView for Windows for 30 days, 

your leased server license expires. The next time you try to open a .QVW file, you receive a message 

indicating that you are using a Personal Edition of QlikView. If that happens, you need to cancel the 

message and lease a license again using the procedure below. 

To lease a QlikView license from the server: 

1. Run QlikView for Windows. 

2. On the File menu, click Open in Server. 

3. In the list at the bottom of the Connect to Server dialog box, select any .QVW file. 

4. Click Open. This leases a license from the server so you can open .QVW files on the server using 
QlikView for Windows. 

Administration Notes 

The system administrator should read these notes during product implementation to determine which 

apply to his or her system. 

Make the wInsight Analytics Module Available to Network Users 

After you install and configure wInsight Analytics on a server, you have several options for making the 

analytics available to those who will use them. The following are some possibilities: 

 Provide each user with the link to the wInsight Analytics site: http://<server name>/QlikView. 

From there, they can open the analytics. You can email the link to them, or you can push it to 

their local computers as a browser bookmark. 

 Copy the wInsight Analytics link that the installation creates on the Start menu of the server 

(Start » All Programs » Deltek wInsight Analytics » wInsight Analytics) to the users’ Windows 

desktops. 

The configuration application and other wInsight Analytics administrative tools are always run locally on 

the wInsight Analytics server, either through direct access to the server or using a Windows Remote 

Desktop Connection. 
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Make wInsight Analytics Module Server a Trusted Site 

To avoid a variety of problems that can occur due to browser internet/intranet security, all wInsight 

Analytics users, regardless of how they access the product, should add the wInsight Analytics Module 

server (http://<server name>) to their list of trusted sites on the Security tab of the Internet Options 

dialog box in Microsoft Internet Explorer. 

Pop-Up Blockers and wInsight Analytics Help 

The wInsight Analytics Module help opens in a separate browser window. If a pop-up blocker is active on 

a user’s computer, the help window may not open. We recommend that all users who use pop-up 

blockers change the settings for the pop-up blocker to allow pop-ups from the wInsight Analytics 

server. 
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Appendix A: If You Need Assistance 
If you need assistance installing, implementing, or using wInsight Analytics Module, Deltek makes a 

wealth of information and expertise readily available to you. 

Customer Services 

Deltek has always maintained close relationships with client firms, helping with their problems, listening 

to their needs, and getting to know their individual business environments. A full range of customer 

services has grown out of this close contact, including the following: 

 Extensive self-support options through the Deltek Support Center 

 Phone and email support from Deltek Support Services analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Deltek Support Center 

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing 

Support Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 

Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Deltek Support Services analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

Attention: Find out more about these and other services from the Deltek Support Center. 
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 Initiate a Chat to submit a question to a Deltek Support Services analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Additional Documentation 

The following table lists the Deltek documentation available for this release. Except where noted, all the 

user guides and quick reference guides listed in this table are available for download from the Deltek 

Support Center. 

Document Name Description 

Deltek wInsight Analytics Module Installation 

Guide 

This guide contains the instructions for installing 

the wInsight Analytics Module as a standalone 

application or as a server-based application. 

Deltek wInsight Analytics Administrator 

Installation Guide 

This guide describes how to install and configure 

the wInsight Analytics Administrator. 

Deltek wInsight Analytics Product Overview This guide briefly outlines the wInsight Analytics 

product architecture and describes each of the 

component modules. The descriptions include 

guidelines to help you determine which of the 

modules your firm or organization needs. 

 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 

from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 

screen for help. 

https://deltek.custhelp.com/
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